
Quick Start Guide

MX280007A 
Mobile InterferenceHunter™

Introduction

Using the Anritsu Mobile InterferenceHunter system, one can find the location of many types 
of interfering sources over a wide range of power levels and in a variety of RF environments, 
including urban canyons with severe multipath. This guide will help you get up and running 
with Mobile InterferenceHunter. For a more comprehensive overview of the software and use 
of its features, refer to the Help that is embedded within the program.

InterferenceHunter System Configuration

Figure 1. MIH System Setup
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Required Equipment:

• MX280007A InterferenceHunter™ Software 

• Anritsu handheld spectrum analyzer
(refer to www.anritsu.com for compatible instruments)

• ZyXel Pocket Router and cables

• Windows Tablet or Laptop meeting the following minimum requirements:

• Quad core processor (> 1 GHz)

• 4 GB RAM

• 1 USB port

• DC power adapter for the for the tablet of laptop

• DC power adapter for the spectrum analyzer

• RF/GPS Antenna (2000-1647-R)

• GPS Antenna (2000-1528-R) (if not integrated into RF antenna)

• RF cable for the directional antenna

Recommended Accessories:

• Yagi antenna

• Mounting Hardware (2000-1801-R)

• Automotive Power Adapter, 12 VDC, 60 W (806-141-R)

Installing the MX280007A Mobile InterferenceHunter Software

1. Place the software installer (MIH_Installer_Vx.xx.msi) on your Windows tablet/laptop 
and double-click the icon "MIH_Installer_Vx.xx" (where x.xx is the current software 
version number).

2. Follow the instructions presented by the installer. If this is a first time installation, you 
may be prompted to install NI-VISA Runtime if not previously installed. NI-VISA 
Runtime is bundled inside the MIH installer.

3. Once completed, a green icon will then appear on your screen (this is the shortcut link to 
the InterferenceHunter application).

4. Double-click the green Mobile InterferenceHunter icon.
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Importing the License Key

1. Open Mobile InterferenceHunter. 

2. View instruments licensed to run with MIH. Click Licensing in the File menu then View 
Licenses. The list of licensed instruments with their serial number will be displayed.

3. If you recently obtained a license for your instrument, you can import your license key 
by dragging the license file onto the Mobile InterferenceHunter program screen.

4. Alternatively, you can import the license file by saving the attachment and then select 
'Import Machine License(s)' from the File menu > Licensing on the main software 
application menu bar (see Figure 2).

Loading Maps

Two types of mapping solutions are available using Mobile InterferenceHunter:

• OpenStreetMap™

• Google Maps™

Ready-made maps are available for cities throughout the world on the Anritsu website. Visit 
http://www.anritsu.com and search for Maps. Alternately, you can construct your own maps 
using the brief instructions provided in the following sections for each mapping solution, or by 
visiting the map’s website for their latest features.

Note The license key file cannot be dropped directly on top of a Google Map.

Figure 2. Importing the License Keys

Note
MIH requires that the instrument be licensed with MIH before it will connect. You 
can run the Mobile InterferenceHunter software without a license key; however, 
the interference hunting capability for the system will not be active.

http://www.anritsu.com/
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Using OpenStreetMap™

Use the OpenStreetMap web site to create and download your map 
(https://www.openstreetmap.org). Once on the OpenStreetMap site (see Figure 3):

1. In the search box, located in the upper left, type in the city that you are looking for and 
click on Go.

2. After you have selected the desired city from the displayed list, you can adjust the zoom 
level and drag the map to the specific area of interest.

3. Click Export located at the top left corner of the page above the search box.

4. To the left of the screen, below the Export button, click the Overpass API link.

5. The map data will then be downloaded to your PC.

Figure 3. OpenStreetMap Website
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6. There are two ways to get the map data into Mobile InterferenceHunter:

• Click, drag, and drop the downloaded map file onto the Mobile InterferenceHunter 
program screen.

• Open the downloaded map from the Mobile InterferenceHunter Settings menu as 
follows:

a. From the main menu, choose: 
Settings | Map Source | Open Source Maps (User provided) (see Figure 4)

b. Browse to your download folder.

c. Select 'OpenStreetMap archive' in the file type drop-down menu.

d. Find the file that you just downloaded and select Open.

When you open the downloaded OpenStreetMap in Mobile InterferenceHunter software, a 
dialog box prompts you to enter the city and country. Then, the map is converted to the 
Mobile InterferenceHunter format and opened in the software. The converted files are saved 
so that when you open that location in the future, no additional formatting is needed.

To open existing maps, navigate to the directory on your tablet/laptop where the maps are 
stored and open any SHP file for your map (see Figure 5 where 'roads.shp' is highlighted in 
yellow for illustration). InterferenceHunter will use all of the map files in the directory for the 
various map layers.

Note The downloaded map cannot be dropped directly on top of a Google Map.

Figure 4. Map Source - Open Source Maps (User Provided)

Figure 5. Open Source Maps
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Using Google Maps™

Using Google Maps requires an Internet connection for the duration of the interference hunt. 
A USB modem is typically inserted into the laptop/tablet.

Navigate to Settings | Map Source | Google Maps (see Figure 6).

The Google Map is then automatically displayed.

Setting Up the Mobile Interference Hunter Hardware

Setting up the hardware for the hunting system involves only a few steps:

1. Place the RF magnet mount omnidirectional antenna on the vehicle rooftop and run 
cables to the interior.

2. If the RF antenna in step one does not also contain a GPS antenna, mount the GPS 
antenna on the roof.

3. Secure the spectrum analyzer in the passenger seat. Use seat belt if available. Connect 
the instrument’s power cable to vehicle power (cigarette lighter adapter).

4. Set up car mount (if used) and attach to Windows tablet.

5. Make all connections. A USB cable or Ethernet cable is used to connect the tablet/PC to 
the spectrum analyzer.

Connection to a Wi-Fi Portable Router

Instead of connecting the instrument directly to a LAN, you can connect it to a Wi-Fi router.

This section documents connection to the ZyXEL MWR102 Portable Router as an example.

Note
Ensure that the USB modem’s radio signal is not interfering with the signal you are 
trying to find.

Figure 6. Map Source - Google Maps
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1. Take note of the router’s SSID and pre-programmed password, which are found on a 
sticker affixed to the router.

2. Using the Ethernet cable included with the router, connect one end to the black LAN 
port and the other end to the test instrument’s Ethernet port.

3. Insert the Mini-B (small) end of the provided USB cable into the router and the Type-A 
(larger) end of the cable into one of the USB ports of your test instrument.

4. Optionally, secure the router to the instrument body using a strip of Velcro or other 
hook-and-loop fastener. You may also place the router in the instrument carrying case, 
if it fits.

5. Use your computer’s Wi-Fi Network Connection utility to find the router. With the 
ZyXEL MWR102 Portable Router, the SSID name will be ZyXEL followed by an 
alphanumeric string unique to your particular router.

6. Connect to this SSID. When prompted, enter the router password noted in Step 1.

7. Set the IP address manually on the instrument. 

a. Set the spectrum analyzer to static IP address 192.168.100.100. 

b. Set the Gateway and Subnet as shown.

c. Make sure the tablet or laptop is set to ‘Always Connect” to the ZyXEL router. 
That way, if the signal is lost for any reason (Instrument power down?), the 
reconnection will happen automatically and transparently.

d. The ZyXEL password is on the back of the pocket router

e. The switch on the side of the ZyXEL should be set to “Router” (not “Access Point”)

f. The LAN cable goes into the ZyXEL LAN port (not the WAN port)

8. Launch the Google Chrome, Firefox, or Safari browser on your PC, laptop, or mobile 
device. Due to compatibility issues with HTML-5, do not connect using Internet 
Explorer (IE).

9. Run MIH Software. 

Figure 7. Instrument Ethernet Settings
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10. Setup the instrument IP address. Navigate to:
Settings menu | Spectrum Analyzer Connection. MIH Connection Setup dialog opens.

11. Click the Ethernet and select one of the following:

• Get: If the instrument is currently has an IP address assigned to it, press this 
button to obtain the address.

• Set: Uses Set to manually enter an IP address of the instrument in use. Enter an 
IP address into the IP address entry window and press Set. 

• DHCP: If the instrument is set for DHCP configuration, press this button.

12. Press Test Connection to confirm communication between the spectrum analyzer and 
MIH software. Status will display in green the word Pass, the instrument model and 
serial number if the connection is successful. If a Fail is returned check hardware cable 
connections, confirm the instrument is licensed, or GPS is synced.

Figure 8. MIH Connection Setup Window
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Starting the Mobile InterferenceHunter System

1. Connect the spectrum analyzer to the tablet/laptop via a USB cable or Ethernet cable.

2. Boot up both the Windows tablet/laptop and spectrum analyzer. If desired, establish an 
audio link between the tablet/laptop and vehicle audio system or other external speaker 
via a cable or Bluetooth connection.

3. Connect an RF antenna and GPS antenna to the spectrum analyzer and turn the 
spectrum analyzer GPS on. Check that you see GPS sync along with the latitude and 
longitude displayed on the analyzer’s screen.

4. Set up the spectrum analyzer parameters.

a. Go to Spectrum Analyzer mode. (Interference Analyzer mode will not work)

b. Setup to view the signal. Here are some useful default settings:

• Center Frequency = Signal center frequency

• Span = 20 MHz

• Reference Level (Amplitude) -40 dBm

• Preamp = On

c. Setup the channel power measurement. Navigate to:
Measure | Power and Bandwidth | Channel Power

• Center frequency = signal frequency

• Channel Power Width = 50% of the signal bandwidth. If it’s a CW signal, 
use 500 kHz for the channel power width.

• Channel Power = On

d. Trace B setup

•  Trace B = Max Hold. This gives you a reference peak value when doing the 
initial direction finding, and helps if you are wondering if you are 
physically near the strongest signal.

Figure 9. GPS Sync with Latitude and Longitude Coordinates

Note
MIH requires that the instrument have GPS Lock before it will pass a connection 
test.
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You are now ready to begin your interference hunt. To start the mobile InterferenceHunter 
program, simply click the start icon (Figure 10) and begin your drive.

An extensive Help is available under the Help menu. Alternatively, press the F1 key to bring 
up the help screen.

Note
A Pre-filter is needed. The Wi-fi signal is fairly close to the roof mounted antenna 
and spectrum analyzers have a very wideband input. Also, you don’t want any 
nearby broadcast signals over loading the analyzer’s front end.

Figure 10. Starting an Interference Hunt

Note

Use the Web Server in a browser window to control the instrument from your 
tablet. This can be done in parallel with MIH, at a small cost of update rate. Use 
Chrome, Safari, or Firefox. Do not use Microsoft’s IE. This allows you to put the 
analyzer on the passenger seat floor, with the soft cover closed, to protect the 
instrument and give a bit of protection to the connections.
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